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About sheet layout

You can use the Sheet Layout editor to create a sheet layout that defines the layout 
of logical pages onto physical sheets. The layout can include both text and 
images.

To define a layout of pages onto sheets, you must:

• Create a sheet layout. See Creating a sheet layout resource on page 10.

• Select the sheet layout for the output connector. See Selecting sheet layout 
on page 13.

Note: You can not use the HTML output connector when post-processing 
documents. To create HTML output, use a File output connector and the 
HTML driver.

Scenario

In the scenario for sorting and bundling of documents, the set of documents that 
was retrieved from the Post-processor repository was split up in two files bound 
for separate mailing machines. See Sorting and bundling documentation.

The post-processing continues with the following:

• A sheet layout is defined to:

– Print the retrieved documents in duplex format onto the sheets.

– Print fold marks to prepare for folding of the sheets to fit into C5 
envelopes.
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About sheet layout
Sheet Layout terms
Sheet layout

You can specify where and how the document pages are printed on sheets, for 
example duplex, landscape, or booklet mode.

You can use variables for the presentation, orientation, and margins settings. For 
example, you can use simplex for the first sheet of a document, and duplex for the 
rest. To use a variable for a specific property, select the property to activate the 
Alias frame for this property.

Media

You can specify the type of paper to use, where to retrieve new sheets, and where 
to put the printed sheets.

You can use variables for all Media settings. For example, you can use a separate 
type of paper for the first sheet in a document. To use a variable for a specific 
property, select the property to activate the Alias frame for this property.

Image

You can add an image on two levels:

• To the whole sheet.

See Adding an image to a sheet on page 10.

• To a specific partition. You must configure a partition before you can add an 
image to the partition. 

See Adding an image to a partition on page 10.

Overlay

You can add an overlay to a sheet. 

See Placing an overlay on a sheet on page 10.

If you want to add an overlay to a page according to a condition, for example if 
the page is the first one in the envelope, you can use the InsertOverlay script 
function.

Example 1 InsertOverlay script

if (isFirstPageInEnvelope())

{insertOverlay("overlay1", 0, 0)

To add a post-processing script, see StreamServe Document sorting and bundling 
documentation.

Repeat

You can print signatures from several documents on a single sheet, or repeat the 
signature vertically or horizontally. You can also repeat the entire sheet. 
Repeating signatures is useful when, for example, printing business cards.
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About sheet layout
Signature

You can specify how the sheet is divided in partitions, by specifying the number 
of rows and columns.

Partition

A partition is a section of the signature that contains one page. You can add and 
configure the partitions in a signature.

Note: Make sure the size of the logical page fits the partition size.

You can:

• Add partitions automatically according to the signature definition.

See Specifying partitions automatically on page 10.

• Add a single partition.

See Specifying a partition on page 11.

Page order

You can define in which order the pages will be printed into the partitions, by 
defining a sequence order expression for the pages.

See Defining page order expression on page 11.

Fold marks

Fold marks display where the border between rows in a signature is located, and 
they indicate where the sheet is supposed to be folded.

In the Fold marks tables, you can double-click a cell or click F2 when a row is 
selected to start editing.

Horizontal fold marks are printed outside the left and right edges of the signature, 
between the rows that you specify.

Vertical fold marks are printed outside the top and bottom edges of the signature, 
between the columns that you specify.

You can specify the default values used for fold mark length, width, and distance.

See Specifying fold mark default values on page 11.

Gutters

The gutter is the area between two rows or columns of partitions in a signature. 
The gutter allows the logical pages that are printed on the partitions to be easily 
visible when the sheet is folded.

In the Gutters tables, you can double-click a cell or click F2 when a row is selected 
to start editing.

The horizontal gutter is the empty area between two rows of partitions in a 
signature.

The vertical gutter is the empty area between two columns of partitions in a 
signature.
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About sheet layout
Measurement unit

You can change the measurement unit used for the length and distance 
parameters, which you can configure in the Sheet Layout editor.

See Specifying measurement unit on page 10

Side-by-side printing

You can configure the output connector to print the sheet layout you defined in 
the Sheet Layout resource on a larger sheet. For example, if you defined your 
sheet layout on A4 media, you can print two of these sheet layouts side by side on 
an A3 sheet. To do this you must specify to print the pages side by side in the Page 
Order definition for the partitions, see Configuring Side-by-side printing on page 
12.

For an example of side-by-side printing, see Sheet layout examples on page 15.

Lookup table

You can use lookup tables for the parameters that you can use variables with.

See the Design Center documentation.

Example 2 Example of a look-up table entry

//Codepage UTF8!
//variable value substitution
1   Simplex
2   Duplex
3   Tumble

This means that if you use a lookup for the Presentation alias, and a $var variable 
is defined for it:

• Presentation is simplex for $var=1

• Presentation is duplex for $var=2

• Presentation is duplex tumble for $var=3
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Configuring sheet layout

To configure the sheet layout of logical pages, you must

• create a sheet layout resource using the Sheet Layout editor.

See Creating a sheet layout resource on page 10.

• select the sheet layout resource to use it in the Project.

See Selecting sheet layout on page 13.
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Configuring sheet layout
Creating a sheet layout resource
1 Right-click the resource set and select New Resource > Sheet Layout.

2 Double-click on the sheet layout resource to open the Sheet Layout editor.

3 Edit the values in the different sheet layout categories. See Sheet layout 
editor GUI reference on page 17.

Specifying measurement unit
1 In the Sheet Layout editor, select Tools > Options. The Options window 

opens.

2 Select the distance unit and click OK.

Adding an image to a sheet
1 In the Sheet Layout editor, select Sheet Layout in the Category tree.

2 From the Sheet Layout menu, select Add Image.

3 Edit the values for the image. 

Adding an image to a partition
1 In the Sheet Layout editor, select Partition in the Category tree.

2 From the Sheet Layout menu, select Add Image.

3 Edit the values for the image.

Placing an overlay on a sheet
1 In the Sheet Layout editor, select Sheet Layout in the Category tree.

2 From the Sheet Layout menu > Add Form Overlay.

3 Edit the values for the overlay.

Specifying partitions automatically
1 In the Sheet Layout editor, select Signature in the Category tree.

2 Configure a signature, either an N-up definition or a custom rows and 
columns definition.

3 From the Sheet Layout menu, select Auto Add Partitions. Partitions are 
added according to your signature definition.

4 Edit the values for the partitions.
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Configuring sheet layout
Specifying a partition
1 In the Sheet Layout editor, select Signature in the Category tree.

2 From the Sheet Layout menu, select Add Partition.

3 Edit the values for the partition.

Specifying fold mark default values
1 In the Sheet Layout editor, select Tools > Options. The Options window 

opens.

2 Edit the Fold marks defaults values and click OK.

Defining page order expression
Every page in a document has a unique sequence number beginning with 1.

To create an expression that represents this sequence number, you can use 
integers, +, -, *, /, (, ), and the following variables:

• s – the sheet number where the logical page is to be printed.

• n – the total number of logical pages to be printed. 

The variable n is retrieved from the lowest of the following values:

• The number of logical pages in the document.

• The MaxSheets parameter specified in the Sheet Layout category.

Examples of page orders

Example 3 Booklet

The number of pages is eight, so 2 sheets are printed.

1st partition (front left): n+2-2*s

1st sheet: The page printed on the front left partition is 8+2-2*1=8

2nd sheet: The page printed on the front left partition is 8+2-2*2=6

2nd partition (front right): 2*s-1

1st sheet: The page printed on the front right partition is 2*1-1=1

2nd sheet: The page printed on the front right partition is 2*2-1=3

3rd partition (back left): 2*s

1st sheet: The page printed on the back left partition is 2*1=2

2nd sheet: The page printed on the back left partition is 2*2=4

4th partition (back right): n+1-2*s

1st sheet: The page printed on the back right partition is 8+1-2*1=7
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Configuring sheet layout
2nd sheet: The page printed on the back right partition is 8+1-2*2=5

Example 4 Cut normal order

1st partition (front left): 2*s-1

2nd partition (front right): 2*s-1+n/2

3rd partition (back left): 2*s+n/2

4th partition (back right): 2*s

Example 5 Cut reverse order

1st partition (front left): n+2-2*s

2nd partition (front right): n/2+2-2*s

3rd partition (back left): n/2+1-2*s

4th partition (back right): n+1-2*s

Configuring Side-by-side printing
1 In the Runtime window, open the connector settings for the output 

connector to be used.

2 Select the Side by Side tab and browse to the sheet layout resource that you 
have created.

3 Select the partition on which to place the pages. You can specify a partition 
number or a partition name that you have defined in the Sheet Layout editor. 
A name must be specified within apostrophes, that is ’<partition_name>’. 
Default is Next (if none is selected).

4 Click OK.
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Configuring sheet layout
Selecting sheet layout
You must configure an output connector to use a sheet layout that you have 
created. You can configure the output connector at Job begin, Document begin, 
Process begin, or Page begin. However, we recommend you to configure the 
connector at Job begin, unless you want to specify a specific document, Process 
or Page.

Note: The priority order when selecting a sheet layout is Page, Process, 
Document and then Job. For example, if you specify different sheet 
layouts on Page begin and Document begin, the sheet layout on Page 
begin is used for the selected pages within the document.

To select a sheet layout

1 In the Runtime window, open the connector settings for the output 
connector.

2 Select the Sheet Layout tab and browse to the sheet layout resource that 
you have created.

3 If you have not defined a Page order, you can select the partition on which 
to place the pages. You can specify a partition number or a partition name 
that you have defined in the Sheet Layout editor. A name must be specified 
within apostrophes, that is ’<partition_name>’. Default is Next (if none is 
selected).

4 Optionally, you can specify the partition in which the first page of the job, 
Document or Process is printed. You can specify a partition number or a 
partition name that you have defined in the Sheet Layout editor. A name 
must be specified within apostrophes, that is ’<partition_name>’. Default 
is Next (if none is selected).

5 Click OK.
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Configuring sheet layout
Importing a sheet layout
1 In the Resource Set window, double-click on the sheet layout resource to 

open it in the Sheet Layout editor.

2 Select File > Import from XML.

3 Browse to the sheet layout file you want to import and click Open.
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Sheet layout examples

Example 6 To print business cards (example)

In this example, business cards are printed onto 10 sheets with 20 business cards 
on each sheet. The business card page defined in the Process tool has a size that 
allows 20 business cards to be printed onto an A4 page.

1 Create a new sheet layout, see Creating a sheet layout resource on page 10.

2 In the Category tree, select Repeat.

3 In the upper Repeat frame, select Stack.

4 In the upper Count box, enter 10.

5 In the intermediate Repeat frame, select Horizontal.

6 In the intermediate Action list box, select Duplicate.

7 In the intermediate Count box, enter 4.

8 In the lower Action list box, select Duplicate.

9 In the lower Count box, Enter 5.

10 Save the sheet layout.

11 Configure an output connector to use this sheet layout, see Selecting sheet 
layout on page 13.

Example 7 To print side-by-side

1 Create a new sheet layout, see Creating a sheet layout resource on page 10.

2 Configure an output connector to use this sheet layout, see Selecting sheet 
layout on page 13.

3 Create another sheet layout, see Creating a sheet layout resource on page 
10.

4 In the Category tree, select Sheet Layout.

5 In the Page Order frame, select Cut Normal Order. The Layout 
Presentation is automatically set to Duplex, or Duplex tumble, depending 
on the Layout Orientation that you have specified.

Note: Make sure the Media size is twice the Media size of the sheet layout 
selected on the Sheet Layout tab.

6 Save the sheet layout.
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Sheet layout
7 Configure an output connector to use side-by-side printing, see Configuring 
Side-by-side printing on page 12.
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Sheet layout editor GUI reference

There are several categories where you can define the sheet layout.

Categories

Sheet layout

Sheet layout settings Variable values

Presentation Duplex Tumble means to turn the page 
on the short side.

Simplex, Duplex, 
Tumble

Orientation The orientation of the sheet. Portrait, Landscape

Margins 
(mm)

Top – The size of the margin from the 
top of the sheet to the signature.

Bottom – The size of the margin from 
the bottom of the sheet to the signature.

Left – The size of the margin from the 
left side of the sheet to the signature. 
The margin is defined when the sheet is 
front side up. Therefore, on the back 
side, this margin is on the right side.

Right – The size of the margin from the 
right side of the sheet to the signature. 
The margin is defined when the sheet is 
front side up. Therefore, on the back 
side, this margin is on the left side.

Values must be in 
points.
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Sheet layout editor GUI reference
Page order None – No page order is defined. The 
partition order specified at Job begin, 
Document begin, Process begin, or Page 
Begin is used for the imposition of the 
pages.

Booklet – The pages are positioned for 
booklet printing. Only 2-up signature is 
supported. See Signature on page 22.

Cut Normal Order – Starting with the 
first page, the first half of the total 
number of pages is positioned on the left 
side of the sheets, and the second half on 
the right side of the sheets.

Cut Reverse Order – Starting with the 
last page, the first half of the total 
number of pages is positioned on the left 
side of the sheets, and the second half on 
the right side of the sheets.

Custom Order – The pages are 
positioned according to the Page Order 
option specified for a specific partition, 
see Partition on page 23.

N/A

Max no of 
sheets

If you want the Page Order option that 
you have specified to be applied to less 
pages than the total number of pages in 
the document, you must specify the 
maximum number of sheets that can be 
used for the pages in the document.

This can be useful, for example, if a 
cutting machine can only handle a 
limited number of sheets.

N/A

Sheet layout settings Variable values
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Sheet layout editor GUI reference
Media

Keep 
documents 
together

No – Each document starts on a new 
sheet.

Yes – A document is printed on the 
sheet directly after the previous 
document.

Front Column – The first page of each 
document is printed on the top partition 
in the column to the right of the previous 
column on the front side.

Front Row – The first page of each 
document is printed on the left partition 
in the row below the previous row on the 
front side.

Front Cell – The first page of each 
document is printed on a partition on the 
next row or column on the front side.

Signature – The first page of each 
document is printed on the next 
signature. This can be useful when you 
are repeating signatures, see Repeat on 
page 22.

N/A

Sheet layout settings Variable values

Media settings Variable values

Paper size The paper size. If you select 
Custom, you must specify 
Width and Height.

A4, Letter, Tabloid, 
Ledger, Legal, 
Executive, A3, A5

Width (mm) The width of the paper in 
millimeters.

The value must be in 
points.

Height (mm) The height of the paper in 
millimeters. The height must 
be greater than the width, as the 
media is defined as portrait 
layout.

The value must be in 
points.
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Image

Type The type of paper, for example 
transparency or drilled. The 
string must comply with the 
output format definition. See 
your output format manual for 
available definitions.

A string

Color The paper color. The string 
must comply with the output 
format definition. See your 
output format manual for 
available definitions.

A string

Weight (g/m2) The weight of the paper in 
grams per square meter.

A string

Gutter change 
(mm)

The increase in gutter size for 
every new sheet. This is used to 
compensate for the media 
thickness when the sheets are 
put together and folded, for 
example when booklets are 
used. See Horizontal gutters 
on page 24.

The value must be in 
points.

Input tray The input tray name. A string

Output bin The output bin name. A string

Media settings Variable values

Image settings for a sheet Variable values

Name The image file name as specified in 
the resource set.

You can use a variable for the image 
name. For example, you can use 
customized images depending on the 
customer ID.

A string

Horizontal 
position (mm)

The horizontal position on the sheet. 
Left is 0.

The value must be in 
points.

Vertical 
position (mm)

The vertical position on the sheet. 
Top is 0.

The value must be in 
points.
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Overlay

Sheet side The side of the sheet where the 
image will be located.

Front, Back, Both

Image settings for a partition

Name The image file name as specified in the resource set.

You can use a variable for the image name. For example, 
you can use customized images depending on the 
customer ID.

Horizontal position 
(mm)

The horizontal position on the partition or sheet. Left is 0.

Vertical position 
(mm)

The vertical position on the partition or sheet. Top is 0.

Position from 
partition origin

The horizontal and vertical positions are relative to the 
partition origin (top left corner of the partition), instead of 
the sheet origin.

Image settings for a sheet Variable values

Form overlay settings for a sheet layout Variable values

Name The overlay name as specified in the 
resource set.

You can use a variable for the overlay 
name. For example, you can use 
customized overlays depending on the 
customer ID.

A string

Horizontal 
position 
(mm)

The horizontal position. Left is 0. The value must be in 
points.

Vertical 
position 
(mm)

The vertical position. Top is 0. The value must be in 
points.

Sheet side The side(s) of the sheet where to print the 
form overlay.

Front, Back, Both
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Repeat

Signature

Repeat settings

Repeat The direction in which the signature is repeated.

If you specify Stack, the whole sheet is repeated. Within 
the stack repetition, you can repeat the signature 
vertically and horizontally.

Reverse Reverse the direction of repeating. By default, repeating 
vertically is from top to bottom of the sheet, and 
repeating horizontally is from left to right.

Action Duplicate – The contents of the signature is duplicated in 
the next signature.

Increment – The next pages of the document are printed 
in the next signature.

Count The number of times the signature is repeated.

Spacing (mm) The distance between signatures, when repeated 
vertically or horizontally.

Signature settings

N-up definition Predefined signatures allow you to configure the sheet to 
contain up to four partitions on each side.

Rows and column 
definition

You can define a custom signature by specifying the 
number of rows and columns for both back and front 
sides.

Set size Width (mm) – the horizontal size of the signature.

Height (mm) – the vertical size of the signature.

Same partitions on 
both sides

The partitions defined for the signature are applied to 
both sides of the sheet.
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Partition

Horizontal fold marks

Partition settings

Partition name The partition name. You can use the name when you 
select a partition and a sheet layout resource on the 
runtime settings, see Selecting sheet layout on page 13.

Constant True – Does not allow logical pages to be printed on this 
partition.

False – Allows logical pages to be printed on this 
partition.

Cell The row and column number of the partition being 
defined. Top left corner is 1,1.

Coord (mm) The X and Y position of the partition on the sheet. Top 
left corner is 0,0.

Sheet side The side of the sheet where the partition is located.

Rotate The counter-clockwise rotation of the page, the form 
overlay, and the image, that will be printed in this 
partition. The Auto option rotates the page, the form 
overlay, and the image to best fit the partition. For 
example, if a page with landscape orientation is to be 
printed in a portrait partition, the page is rotated to fit in 
the partition.

Center small pages If the logical page is smaller than the partition, the page 
is centered in the partition. If not selected, the page is 
positioned in the upper left corner of the partition.

Page order A mathematical expression that represents the sequence 
number of the page to be printed in this partition. See 
Defining page order expression on page 11.

Horizontal fold marks settings

Begin row Specifies the row in the signature above which the first 
fold mark is printed. Enter 0 to start at the top.

End row Specifies the row in the signature under which the last 
fold mark is printed.
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Vertical fold marks

Horizontal gutters

Distance The distance between the signature and the closest edge 
of the mark.

Length The length of the fold mark.

Width The width of the fold mark.

Automatically add 
fold marks

Click to automatically add horizontal fold marks to every 
place where it is possible, that is on the horizontal limit 
between rows in the signatures, as well as above the first 
row and under the last row.

Horizontal fold marks settings

Vertical fold marks settings

Begin col Specifies the column in the signature to the left of which 
the first fold mark is printed. Enter 0 to start at the top.

End col Specifies the column in the signature to the right of which 
the last fold mark is printed.

Distance The distance between the signature and the closest edge 
of the fold mark.

Length The length of the fold mark.

Width The width of the fold mark.

Automatically add 
fold marks

Click to automatically add vertical fold marks to every 
place where it is possible, that is on the vertical limit 
between columns in the signatures, as well as to the left 
of the first column and to the right of the last column.

Horizontal gutters settings

Begin row The upper row in the signature, under which the 
horizontal gutter is located. Top row = 1.

End row The lower row in the signature, above which the 
horizontal gutter is located.
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Vertical gutters

Distance The size of the gutter. If you leave this empty, the size is 
calculated from the Gutter change value. See Media on 
page 19.

Horizontal gutters settings

Vertical gutters settings

Begin col The left column in the signature to the right of which the 
vertical gutter is located. Left column = 1.

End col The right column in the signature to the left of which the 
vertical gutter is located.

Distance The size of the gutter. If you leave this empty, the size is 
calculated from the Gutter change value that you can 
specify in the Media settings.
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